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This software is produced for professional and research purposes. The use of
the software for the purpose of recording geophysical data and / or assessment
of risks and mechanical characteristics of soils is reserved for qualified and
specialized  personnel  such as  doctors  of  engineering,  architecture,  physics
and geology, having also followed specialization courses in geophysics and
structural  calculation.  All  certifications  regarding  this  material  are  the
responsibility of the end user.
The software is provided in its most updated version, without any express or
implied warranties. The developer of GEOEXPLORER DOWNHOLE is not
responsible for any loss, injury or damage of any kind in the event that the
software is used in situations of vital importance and without the necessary
technical expertise essential for the validation of the data obtained and does
not accept responsibility in the case of inappropriate use of the product.
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 1  Introduction

The Downhole module was developed with the aim of being able to verify the quality of the
data through the management of the spy geophone, to be able to process acquisitions with
regular  and  irregular  geometries,  without  limitations,  using  different  processing  methods,
returning the seismic-stratigraphic profile with the speeds and the geophysical parameters that
can be calculated.

 2  Downhole

To use the module is mandatory to plug the  USB license
dongle  to  the  PC  and  to  start  the  program  from  the
GEOEXPLORER suite.

Please note: it is recommended to run the
software as administrator.

The main page of the software is the Dataset tab where is possible to load in different ways
the dataset recorded in the field or directly the seismograms ready for the picking.
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 2.1  Menu bar

From the File menu is possible to load the data in different
ways:

1. New elaboration:  Resets the program and makes it
available foe new processing 

2. Import  files: This  option  allows  to  load  data
massively,  even  if  the  dataset  has  been  recorded
with a third part seismographer.

Please  note:  it  is  possible  to  load  SEG 2
files.  However  the  geometry  and  others
information  must  to  be  applied  manually
(See  chapter  2.2.1 Dataset page  12).  The
software will automatically convert the data
in .drm.

3. Open CDH: It is possible to load directly the dataset recorded by the Downhole 
module of GEOEXPLORER DoReMi. (please see the GEOEXPLORER DoReMi 
manual)

4. Open file – P: It is possible to load directly the P seismogram for picking

5. Open file – S: It is possible to load directly the S seismogram for picking. It is possible
to load the Overlap seismogram or the invert & sum seismogram.

Please note: for points 4 and 5, if the geometry is missing, the software will
open a pop up for the geometry setting. It is also possible to manually set the
geometry (see chapter 2.2.4 Picking page 21)

Please note: it is recommended to always make a backup copy of the file.

6. Work:  This menu allows to save, search,  load works and see the last  saved works
history.
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The Load work option allows to select a
previously  saved  folder.  This  folder
contains a previously processed dataset.

The  Search  work  window
allows to look for a work in
the  device  and  in  the  time
interval selected.

If the dates selected are both
the  current  day  the  search
will  be  done  on  the  whole
device without restriction.
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This software generate a temporary copy of the uploaded files on which it works. When you
proceed with saving the work, the program generates a folder with the selected name in the
desired position. The folder contains the original files, the support files and the processing
information, thus creating an image relating to the status of the processing process at the time
of saving.

Please note: in addition to making a backup copy of the original files, it is
advisable to proceed with periodic backups in different folders,  in  order to
preserve  the  various  processing  steps.  The  software  also  provides  the
overwriting function in the same save folder, but we DO NOT RECOMMEND
this procedure

Please note: Manually modifying the contents of the save folders can lead to
anomalous  behavior  of  the  software  and/or  to  the  loss  of  processed
information. WE STRONGLY NOT RECOMMEND modifying save folders.

The Tools menu allows to:

1. Recalculate layers: It recalculates the values from the Intercept tab and also highlights
the invalid values in red.

2. Recalculate pseudo and equivalent: It recalculates the values from the Pseudo-interval
and Equivalent velocity tab and also highlights the invalid values in red.

3. Settings: A screen opens in which it is possible to set limit values for the evaluation of 
velocities and Poisson. The default values are those displayed in Illustration 2.1-6. It is
possible to change these values within certain limits of consistency. For Vp the largest 
settable value is 14000m/s, while for Vs 8000 m/s. The minimum is instead 1 m/s, 
both for Vp and Vs. For Poisson values, the largest settable value is 0.5, the smallest is
0.
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The Report menu, allows to set all the work specific information for printing the pdf, as well
as the photos the elaborations

The ? menu gives the software information like version and contacts.
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 2.2  Tabs

The software is structured in tabs which will guide the user through the whole the elaboration
process:

1. 2.2.1 Dataset

In this tab is possible to load a dataset and set the geometry

2. 2.2.2 Channel selection

In this tab is possible to select the horizontal channel for each horizontal shot

3. 2.2.3 Correction

In tab is possible to evaluate the spy geophone correction and apply it

4. 2.2.4 Picking

In this tab is possible to pick the first break

5. 2.2.5 Data control 

In this tab is possible to revise the picking and see a resume of it

6. 2.2.6 Intercept

In this tab is possible to use the intercept method

7. 2.2.7 Pseudo-interval

In this tab is possible to use the Pseudo-interval method

8. 2.2.8 Equivalent velocity

In this tab is possible to use the Equivalent method
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 2.2.1  Dataset

As explained before, on this tab is possible to load a dataset. Selecting one of the files, it is
possible to see a preview in the box on the right.
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By right-clicking on the desired row it is possible to
enable or disable it (Enable/Disable) or delete the row.

With  Set  geometry  is  possible  to  set  the
geometry for the massive SEG import. The SEG
import will not have geometry information.

Start (m): it is possible to set the start depth.

Step  (m):  it  is  possible  to  set  the  step  value
between the acquisitions.

Shot type: It  is  possible to set  the type of the
shot.

Please note: the Set geometry allows to set the geometry and shot information
massively. To do this, select the desired files for editing. (Drag and drop with
the mouse or Shift+click).  It  is  recommended to load the data as shot type
dataset and edit them before load the second shot type dataset.

To modify single information just double click on the desired cell. It is possible to change
Depth, Shot, and enable/disable the file using the checkbox.

Please note: double clicking on Shot will change automatically following this
pattern  P,  R,  L…  Clicking  on  the  Enable  cell  is  possible  to  switch  the
habitation from YES to No and vice-versa

It is possible to browse the table using the arrow keys, and modify the values with the space
bar.
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On this tab is possible to, in order from top to bottom, to select the P channel, enable the Spy
geophone option, select the channel of the spy geophone.

The selected P channel will be used to process P waves

Enabling the Spy geophone option, the channel selected as spy geophone or the geophone on
the surface for the quality check of the data will be removed from the display.

The channels selected as P and as spy geophone will be deleted from the channel selection in
the Channel selection tab.

Please note: it is not allowed to select the same channel both for P and the spy
geophone.  In that  case,  an error message will  be shown ad it  will  not be
possible to continue with processing.

Once  completed  the  dataset  configuration,  click  on  Order  by  depth.  The  dataset  will  be
rearranged according to  depths  and the  Check button  will  be  enabled.  By clicking on it,
checks will be carried out on the dataset and, if successful, the next tab will be displayed.

If there are more shot enabled with the same properties the software will automatically stack
the seismograms. If there are no enabled seismograms, or if data have not been acquired at a
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specific depth, the software will skip the depth.

Please note: if there is only one measure between the right and the left for the
S  measures,  the  program  will  allow  the  choice  between  the  following
possibilities:
Automatically generate a synthetic seismogram resulting from the inversion of
the present data; Modify the dataset to skip the quota, disabling the present
one; Enable the disabled file; Upload the missing file.

15 of 49 SARA electronic instruments s.r.l – Italy – www.sara.pg.it – info@sara.pg.it

Illustration 2.2-6

http://www.sara.pg.it/


GEOEXPLORER DOWNHOLE   –   2.  2  .  1   – USER MANUAL  

 2.2.2  Channel selection

On this tab is possible to select the desired left and right shot and to create the best overlap
and invert & sum that are possible to see on the preview. This selection can be done manually,
or automatically.

The buttons over the seismograms:

• Automatic select all

• Automatic select current

allow respectively to automatically select the left and right channels for all depths or for the
current depth.

Please  note:  the  software  perform  the  automatic  selection  analyzing  the
amplitude of the channel. This selection does not mean is the best solution; we
recommend to check manually every depth.

The button Write P and S create the P and S files that, if the Spy geophone option has been
selected, will be loaded in the Correction tab, otherwise they will be used to create the final
seismograms that will be opened on the Picking tab.

The  seismogram  windows  have  the  same  viewing  functions  of  the  GEOEXPLORER
DoReMi, so we refer to the GEOEXPLORER DoReMi manual for further explanation.
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Right click on both left and right seismograms to
open  the  context  menu  where  is  possible  to
manual select the desired channel with Select the
horizontal channel.

On the left is possible to see the selection progress:

• Blue: highlight the selected file

• Green: the selection has not changed from the default

• White: the seismograms has not visualized

• Light blue: it has been done the automatic or manual selection of
the right shot

• Purple: it has been done the automatic or manual selection of the
left shot

• Red: it has been done the automatic or manual selection of both
shots

Please note: the default selection is done by the Downhole
module in the GEOEXPLORER DoReMi for a .cdh file.
For  a  dataset  from  a  third  part  seismograph  the
GEOEXPLORER DOWNHOLE select the last channel.
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 2.2.3  Correction

In this view it is possible to correct the seismograms of the P, left S and right S waves, shown
in the right graph, by means of the respective seismograms of the spies, shown in the graph on
the left.

Verify button allows to check which channels needs to be corrected according to the selected
configuration. Those channels will be highlighted in yellow.

Process  button, applies the correction to the seismograms according to the chosen method,
generates the final corrected files and loads them in the Picking tab.

To perform the correction it is necessary to pick on each of the left seismograms.

It is possible, inside the Select seismogram, to select what seismogram to visualize for the
picking. The seismogram window has the same function of the GEOEXPLORER DoReMi
seismogram window.

In order to carry out the picking just hold SHIFT key and To perform the picking hold the
SHIFT key and click with the left mouse button on the point of the first arrival. Holding the
left mouse button and the SHIFT key, it is possible to pick the other channels by dragging the
cursor along the seismogram.
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It is possible to browse the seismogram using the keyboard. By  Left  and  Right arrows the
channels will be selected. (the currently selected channel is highlighted by a different line
color).  Up and Down arrows move the picking op or down 1 sample at a time. Pag Up and
Pag Down keys move the picking op or down 1 millisecond at a time.  Home and End keys
move the picking at the beginning or at the end of the window.

There are 3 correction methods (green box):

1. None: No correction needed.  Process button will be enabled. It allows to proceed to
Picking without any correction. In that case it is not needed to pick the seismograms of
the spies.

2. Selected Channel: The correction is made on the basis of the picking carried out on
the  reference  channel  (by  default  the  first).  A different  reference  channel  can  be
selected for each of the seismograms. 

3. Fixed Value:  The correction is  made on the basis  of a  user defined value.  In  the
checkbox on the side a different value can be selected for each of the seismogram. If
the value has not been set for a seismogram, it will be automatically set as the average
of the picking values of all the channels of the same.

The correction tolerance is set with the  Tolerance  field.
This is the minimum value for which the channel picking
must  deviate  from  the  reference  value  to  make  a
correction necessary.

The context menu that is shown by right-clicking on the
seismogram, has some additional functions in addition to
display functions.

The  Pick  function allows to perform the picking on the
channel.  The  Select  as  Reference  function  allows  the
user  to  select  the  desired  channel  as  the  reference
channel for the correction mode: Selected Channel.

These functions work separately on each channel.

Other functions are in the generic seismogram
menu. These functions allows the user to better
manage the processing.

In  addition  to  display  functions  there  is  the
mirror tool, which, allows the user to mirror an
acquisition.  It  is  useful  when  the  acquisition
has been recorded down-top.
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Please note: the program treats each acquisition as top-down, then assuming
that the first channel is the most superficial acquisition. 

Once the correction tab is set, and the picking has been completed, using the Verify button the
dataset will be analyzed in search of the channels that need to be corrected. These channels
will  be highlighted in yellow. At this  point it  is possible to repeat the operation until  the
desired result is obtained or press the  Process button, which it will apply corrections to the
dataset and will enable the Picking tab.

The program checks the difference in ms of each picking of the spy geophone with respect to
the selected method and translates the corresponding channels in the P and Sh seismograms
by a value equal to the ms of difference between the picking value of the indicator and the
value used as a reference (dependent from the selected methodology) if it exceeds the selected
tolerance.
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 2.2.4  Picking

In this tab is possible to perform the first break picking on the various seismograms. These
seismograms can be opened directly (see chapter  2.1 Menu bar pag  7) or generated by the
process explained on the previous chapters.

P pickings are represented in red, S pickings are represented in blue. Furthermore, if enabled
the option Show Pickings → Both P And S, on the seismogram of the P the pricking of the S is
shown and vice versa, so as to be able to visually compare the two pickings.

The table on the right shows the speed values on which the picking has been carried out for
each channel. You can manually change these values by double clicking on the desired cell.

Please note: is not mandatory to load the invert & sum and the overlap for the
S shot seismogram. 
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It is possible, inside the  Select seismogram, to select what seismogram to visualize for the
picking. The seismogram window has the same function of the  GEOEXPLORER DoReMi
seismogram window. To be able to perform the picking just follow the same instruction given
for the Correction tab.

Please  note:  the  picking  performed  on  the
seismograms S (Invert Sum and Overlap) is
simultaneous.  This  means  is  possible  to
perform the picking only on one of them.

Whit the right click on the seismogram is possible to open
the  menu  where  there  are  new  features  with  the
visualization options.

The Pick function allows the user to perform the picking. It
is also possible to set the depth of the channel in case of
irregular acquisition, by Adjust channel depth.

These functions work separately on each channel.

On the generic seismogram menu are present other geometrical setting function:

1. Set geometry

2. Mirror

Set  geometry  allows to quickly manage the geometry of the acquisition by being able  to
change the position of the shots separately and the depth progression, as well as the height of
the most superficial measurement. 

The  Mirror function allows to flip the acquisition.  This function is  useful in the case the
dataset is recorded as down-top.
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Please  note:  the  GEOEXPLORER DOWNHOLE assumes the acquisition  is
performed as top-down.

Once the picking is done, the button Process allows to elaborate the acquisition on the other
Tabs.

Please note: the software check if the picking has been done. If it find more
then 3 consecutive channel with the same picking it will ask to do the picking
assuming has not been done. Is the geometry is not set the geometry window
will open.

Please note: if the geometry of the shots and / or the position of the channels
on the vertical is absent, the program automatically opens the Set geometry
window indicating which information to insert.
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 2.2.5  Data control 

On this Tab is possible to see the resume of the acquisition and picking. On the table are
shown the picking and the relative geometrical correction.

On the table  is  possible  to  edit  the single picking
value;  by  double  click  on  the  desired  cell  and  is
possible to edit the picking value and with the enter
button  on  the  keyboard  is  possible  to  apply  this
modification  for  the  new  geometrical  correction
computation.

With the right click you can open the menu where is
possible to:

• Disable cell: disable the selected cell

• Enable cell: enable the selected cell

• Enable all cells: enable all the cells

• Export table: Export the selected table to .csv

24 of 49 SARA electronic instruments s.r.l – Italy – www.sara.pg.it – info@sara.pg.it

Illustration 2.2-17

Illustration 2.2-18

http://www.sara.pg.it/


GEOEXPLORER DOWNHOLE   –   2.  2  .  1   – USER MANUAL  

The dataset is automatically updated based on the enabled cells

Please note:  the disabled cells  are not  used for the
computation on the other tabs.

In each of the visualization windows it is possible by right-clicking
the mouse, to copy the image to the clipboard or save it to file.
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 2.2.6  Intercept

In this tab is possible to do the intercept interpretation. The software will plot the enabled
geometrical  corrected  pick  on the  Data Control  tab,  allowing to  draw the segment  for  P
arrival and S arrival interdependently.

With the options Set intercept it is possible to pick the relative P arrival segment or S arrival
segment.

Once selected the wave, the software will move the mouse on the axis origin and from there
will be possible to see the preview of the segment. To set the segment it is need only the left
click on the desired position. From this second point the software will plot the preview of the
second segment.

On every moment with the right click of the mouse it is possible to stop the picking process
and selecting again the option is possible to start from the last point picked.

To end the picking is mandatory to pick a point below the last represented depth.

Placing the mouse over one knee of the intercept, it will be highlighted. Shift + Click on one
knee of the intercept to reposition the knee in another point of the graph.
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Right clicking on a vertex of the intercept line will show a context
menu with the following options (Illustration 2.2-23) 

• Move:  It allows the user to reposition the vertex on the
graph by clicking on another point on the graph

• Delete: Removes the selected point

• Continue Intercept: It allows the picking of intercepts to
be resumed from the last point positioned

Right clicking along the intercept line will show a context menu
with the following options (Illustration 2.2-24) 

• Add  Point:  Allows  the  user  to  position  a  new  point,
breaking the segment that was clicked.

• Continue Intercept: It allows picking to be resumed from
the last point entered

• Delete Intercept: Deletes the selected intercept

By enabling the Round depth option, at the time of the picking the depth value is rounded to
the nearest unit.

The software will  fill  the top left  table  with the depth and velocity  information of every
picked segment for the P and S waves. Picking P and S the software will populate the bottom
left table with the layer interval computed with the combination of P and s stratigraphy.

With the options Delete intercepts it will be possible to delete the desired profile.

Please note: is not possible to pick a value above the previous in time and 
depth. For example if you pick 8,1ms is no possible to pick 7ms and if you pick
a 7m is no possible to pick a 6m.
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Illustration 2.2-25

Using the text boxes Offset and Vs eq. It is possible to set the software for the calculation of
the equivalent Vs. In the offset field it is possible to indicate from what depth to start the
calculation, while in the Vs eq field the depth at which to calculate the Vs eq is defined in
meters. The result of the calculation is shown on the right in m/s.

With the option Enable layer the software will show the stratigraphy and relative modules i
(see formulas in the chapter 5.4):

• Poisson

• Density (RHO)

• Gamma

• Young

• Shear

The  option  Exclude  invalid  value allows  to  do  not  plot  out  of  range  Poisson  values.
(Illustration 2.2-26)  The default values are 0,16 the minimum limit, and 0,5 the maximum.
These values can be changed in the Tools → Settings menu. (see Chapter  2.1 )
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The  Tolerance parameter  allows  the  user  to  define  a  tolerance  value  for  the  layers,  if  a
tolerance value greater than 0 is assigned, all the layers with thickness less than the tolerance
value are ignored as they are not significant. The maximum tolerance value that can be set is
1m.
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 2.2.7  Pseudo-interval

This tab elaborate the dataset as it has been recorded with 2 sensor in the well (true interval).
The software  will  compute  the  time difference  between two consecutive  measurement  to
evaluate the interval velocity.

Please note: if the acquisition has been done with a 1m spacing, and for some
reason is missing a depth, or it has been disabled in the Data control tab, the
software  will  compute  the  interval  velocity  analysis  with  the  closer
measurement, in this case the step will be 2m.

As for the intercepts it is possible to calculate the  Vs eq on the basis of the layers and the
velocities calculated using the Pseudo-Interval method. The calculation takes place using the
same methods and with the same Offset and Vs eq values, which are synchronized between
the two views.

With  the  Exclude  invalid  values option  the  software  will  eliminate  from  the  graphical
representation the values that, according to the verification of the calculations, return outliers.
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On the table is possible to see the result of the velocity analysis (Vp and Vs) and relative
selected module. From the drop-down menu is possible to select the module.

With the right click of the mouse on the table is possible to enable/disable cells, row and
column and copy the data as text or image.

Please note: the software will execute some data control:

1. Checks if there are negative velocities

2. Checks if the Vs is bigger or equal to Vp

3. Checks if there are Poisson values out of range. The default values are
0,16 the minimum limit,  and 0,5 the maximum. These values can be
changed in the Tools → Settings menu.(see chapter 2.1).

If one of the three check is wrong, the software will disable automatically the
cells  with wrong values.  Is  possible  to visualize or not these values on the
various representation enabling or disabling the option Exclude invalid values.
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 2.2.8  Equivalent velocity

This tab works as the Pseudo-interval tab, computing the velocities and the modules between
the first acquisition and the various depths.

Even in this tab the data control are done, as on the previous tab.
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 3  Introduction to data acquisition

The in hole microseismic investigation is the main technique for the direct determination of
the elasto-mechanical properties of the subsoil; the prospecting is carried out in a specifically
equipped  hole  and  allows  to  determine  the  propagation  speed  of  the  compression  or
longitudinal P waves, and the shear or transverse S waves. This is done by measuring the
travel time of a wave train from the position of a specific source to the sensor (or sensors)
prepared and made integral with the ground or in the hole.

Three alternative methods are available for in hole seismic measurements:

a) Surface energization and in hole reception, and vice versa.

b) Energization and reception in the same equipped hole.
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c) Energizing in a hole and receiving in one or more adjacent holes.

The most used microseismic techniques include the following detection techniques:

a) Down-Hole (DH): the energization station is located on the surface and the sensor
body are located at a specific depth in the hole. 

b) Up-Hole (UH): the energization station is located in the hole and the sensors are
placed on the surface, generally at a different distance from the equipped vertical. 

c) Cross-Hole (CH): the energizations are produced in the hole, on a specific vertical
while the sensors are arranged on a different equipped vertical, at a specific distance
from the first. 

The  Down-Hole and  Up-Hole investigation  techniques  are  the  best  known  and  most
widespread, while the Cross-Hole technique is less used, as it presents higher costs for setting
up the test station.

The  Down-Hole and  Up-Hole techniques  allow to determine the  elastic  behavior  of  soils
along the direction normal to the ground (P and SH waves), while the Cross-Hole technique
characterizes the behavior of the subsoil with regard to the propagation of the seismic input on
the conjugate direction. 

This quickstart explains the correct acquisition method for the Down-Hole technique and the
processing method.
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 4  Data Acquisition

The investigation technique is based on the determination of the time it takes the wave train to
travel the known distance from the energization point to each of the receiver positions. 

To determine the time taken by the wave train it is necessary to have:

a) accurate precision in determining the energization instant (trigger) and a control of
possible  “delays”  at  the  trigger  (spy  geophone),  for  the  identification  of  the
energization instant.

b) high resolution of the signal, through a high signal / noise ratio, which allows the
recognition of the instant of first arrival of the wave train at the sensor.

c) adequate sampling frequency, which allows the instant of first arrival of the wave
train to be determined with the greatest possible accuracy.

d) length of the recording signal that allows you to sample the wave train at least for a
duration that appreciates an attenuation of the amplitude of the recorded signal of at
least 1/3 of that on first arrival. 

 4.1  Techniques of preparing the test vertical: characteristics and controls

The vertical test consists of a geognostic survey conducted with continuous or destruction
coring, with a diameter between 100mm and 140mm, completed with PVC or ABS DN80
piping, suitably cemented to be made integral with the surrounding ground.

The  pipeline  can  also  be  stabilized  by  filling  with  fine  sand,  in  particular  geological
conditions; exceptionally and only in particular lithostratigraphic conditions it is possible to
proceed in non-equipped holes.

The survey can also be carried out in piezometric verticals or holes equipped for inclinometric
measurements, also completed with aluminum, fiberglass or plastic pipes, where it is possible
to make the recording /  energization apparatus adhere and make integral (with pistons or
homologous systems) in the hole with the pipe.

It is considered particularly useful to know the stratigraphic succession involved up to the
expected depth of survey.

Before carrying out the survey, it is necessary to wait for the withdrawal of the cement
mortar: a waiting period of about 20 days must be foreseen, where mortars with specific
aging accelerating additives have not been used.

Checking the practicability of the hole and the integrity of the completion pipeline is  the
preliminary phase to the prospecting procedure.

The maximum depth in which detection by Down-Hole or Up-Hole techniques is reliable does
not exceed 50-60m.

If you do not have certain data on how to complete the equipped forum, it is mandatory to
carry out an investigation with a "witness" (it is a good idea to proceed with this procedure
even if you have this data), which does not involve the possible loss instrumental in case it is
not recoverable the control tool.
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 4.2  Preparation of the detection station

The  test  plant  is  set  up  around  the  equipped  hole,  placing  the  following  components  in
appropriate positions

a) The seismograph and the PC must be positioned in such a way as to be able to: view
the  recordings,  note  peculiarities  of  the  signal,  assess  the  need  to  proceed  with
multiple  energizations,  perform  stacking  operations  (summation)  or  whatever  is
necessary to obtain signals of adequate readability.

b) The energization station, for the P and SH waves, must be placed contiguously at a
distance between m 2 and m 5 from the vertical of the hole (in order to minimize the
refractive effects of the seismic ray and avoid channeling effects of the wave train
along the vertical hole). It is necessary to appropriately ballast the sleeper to be used
for  energizing  in  shear  waves  and  verify  the  feasibility  of  operating  a  reverse
polarization of the waves (as shown in the red box).

c) Spy geophone to be used to check for any delays introduced in the recording from
the moment of energization, due to incorrect operations (as shown in the yellow
circle).

Red box P and SH sources, violet arrow head hole, yellow circle spy geophone.
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The  site  must  be  set  up  in  such  a  way  as  to  be  able  to  carry  out  and  supervise  each
measurement  operation,  to  verify  the  height  of  the  sensor  in  the  hole,  to  verify  the
energization procedures and for a quality check in the field.

The construction site must provide for protection to the instrumentation and operators, in the
expected climatic conditions, and the foreclosure of the detection area to the uncontrolled
transit of people and vehicles, for the entire duration of the survey.

The use of a pulley arranged in axis with the hole allows you to avoid breakages and damage
to the data cable and the safety cable of the system due to the edge of the hole at the wellhead.
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 4.3  Seismic sources

The seismic sources to be used during the test must have adequate energy capacity, in relation
to the maximum depth that is expected to be used in the test. They must also produce elastic
waves with a wide range in frequency and have low noise.

Illustration 4.3-1

The energization station must be equipped with a strike plate for energizing in P waves, and a
sleeper, suitably ballasted, for energizing in SH waves.

Each  strike  station  must  be  equipped  with  a  "trigger"  for  recording  the  moment  of
energization;  any operational  errors  that  lead  to  incorrect  assessments  on  the  moment  of
energization must be corrected by evaluating the signal with the spy geophone, appropriately
prepared for this purpose.

The energization station for P and transverse waves must  be placed at  a distance usually
between 2m and 5m from the measurement vertical.

The sleeper for energizing for shear waves must be suitably ballasted to ensure adherence to
the ground during energization, for efficient transmission of the signal to the ground.

The sleeper is placed on the ground previously leveled with an orthogonal direction to the
source-hole  joining;  the  stress  produced  is  carried  out  at  both  ends  with  the  same  axis
orientation.

The energization at  the two ends of  the  sleeper  is  necessary to  allow the polarization in
opposition of the shear waves and facilitate their recognition during data processing.

The sleeper must not have metal fittings, bolts or anchors that may produce unwanted "noise"
at the time of energization.

The  position  of  the  energization  points  must  be  maintained  and  must  not  be  changed
throughout the test run.
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 4.4  Sensor

The forum registration system consists of:

a) Vertical and horizontal velocimeter (s) or accelerometer (s) with 3 or 5 channels. 
they are made integral to a specific height along the measurement vertical or 
arranged in a chain, at a predetermined mutual distance, in the previously chosen
recording depth.

The receivers must be made integral with the walls of the hole, except for measurements in
holes filled with water, where suspension receivers can be used.

The characteristics of the sensors must be adequate for the sensitivity and resolving capacity
of the signal to be interpreted; ordinary instrumentation provides for the use of velometric
sensors with a frequency of its own between 8 and 14 Hz with a flat response for frequencies
above 10 Hz.

If  only  one recording group is  used,  there  is  1  vertical  sensor  and 2  or  more  horizontal
sensors, arranged on a horizontal plane at variable angles of 90 ° (2 sensors), 60 ° (3 sensors)
or 45 ° ( 4 sensors).

An additional receiver must be set up in the measurement area to check for any "delays" on
the moment of energization recorded by the dedicated trigger.

This receiver generally consists of a vertical velocity sensor, kept at a predetermined distance
by the energization system, which allows you to introduce any corrections on the wave arrival
times to the different receivers, during subsequent measurements; for this sensor there is no
need for particular technical specifications.
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 4.5  Campaign data acquisition and setup

The acquisition unit is connected to the recording system, to the control sensor and to the
trigger connected to the energization system.

It must be set up with a sampling frequency, a recording duration and, possibly, with gains
appropriate to the survey, in relation to the seismic source used in the prospecting, the nature
of the subsoil soils, the "environmental noise" and the maximum depth that occurs. plans to
reach into prospecting.

The sampling required is greater than 5000 Hz; we indicate the use of an SPS of 8000-10000
Hz and with a recording length of 250-350 ms, for investigations on verticals of about 30
meters depth equipped in loose soils of medium tenacity / consistency.

Campaign registrations do not involve the use of pre-filtering, stacking, summation or other
functions on the first acquisition data. The operations of analysis and pre-processing of the
field recordings must foresee the conservation of the original acquisition data.

The  field  data  must  be  prepared  in  such  a  way  as  to  allow  the  identification,  for  each
recording, of the type of receiver, of the height of the housing in the equipped hole, of the
energization  methods  at  the  source  and  of  the  distance  of  the  seismic  source  from  the
detection  vertical,  as  well  as  that  of  the  acquisition  specifications  in  terms  of  frequency,
duration and gain of the signal, also by means of an explanatory report associated with the
data.
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 4.6  Execution procedure of detection – Down-Hole acquisition technique

Micro-seismic detection with Down-Hole techniques of the elastic characteristics of the soils
in the subsoil, through the use of a specifically equipped hole, involves the following steps:

a) positioning  of  the  recording  system  consisting  of  the  oriented  sensors,  at  a
predefined depth

b) locking  of  the  sensors  at  the  defined  depth,  through  hydraulic,  pneumatic  or
mechanical systems

c) energization of compression or longitudinal waves and recording of the resulting
signal to the sensors housed in the hole and to the surface control sensor, for the
predefined time from the instant indicated by the trigger

The distance between the energization station and the vertical measurement, indicated as
the offset value, is usually between m 2 and m 5. This is the appropriate value to minimize
the refractive effects of the seismic ray in the subsoil and exclude channeling effects of the
wave train along the vertical of the hole.

Energization in the context of each measurement, must be carried out in the same location
for all subsequent acquisitions on the vertical, in order to exclude that areal variations of
the elastic characteristics in the immediate subsoil do not allow a correct interpretation of
the data

d) energization of shear or transverse waves, for the normal and conjugate impulse.
Recording of the resulting signal to the sensors housed in the hole and to the surface
control sensor, for the predefined time starting from the instant indicated by the
trigger.

Normal and conjugate energization, by applying the stress at the two ends of the sleeper in
the  direction  of  axis  orientation,  produces  polarized  waves  with  opposing  phase  that
allows easier recognition, during the data processing phase.

e) unlocking of the sensors and repositioning at a different depth

The  procedure  is  therefore  repeated  with  the  same  operational  phases  along  the  survey
vertical.

The  distance  between  the  measurements  corresponds  to  the  repositioning  interval  of  the
receiver (or the spacing between the geophones of a system of multiple receivers in the hole);
the  interval  is  chosen  according  to  the  accuracy  and  efficiency  required  for  speed
measurements and is generally between 0.5 m and 5 m (in general the measurements are
carried out every m 1).

The survey can be conducted by proceeding towards the maximum depth of investigation
(from top to bottom) or from the maximum depth to the top of the equipped hole (from
bottom to top).
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 5  Processing

Processing  can  be  carried  out  with  different  methodological  approaches.  In
GEOEXPLORER DH module it has been made possible to use the graphic method of the
intercepts and the interval method in the resulting Pseudo-interval and Equivalent.

In the first instance, the data is loaded, the geometric settings are checked for correctness and
the horizontal channels are selected. After that, the spy geophone is checked and, if necessary,
corrections are applied to the channels that have triggering problems, which can be caused by
badly positioned blows, local variations at the strike point (compaction, displacement of the
plate from the trigger, etc.).

It is necessary to pick up the first arrivals on the seismograms of the spy geophone, thanks to
which the software will check the triggering of the various channels. Once the correction
method has been chosen and applied, the picking files will be generated.
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Example of trigger error and correction applied through the use of the spy geophone, which
allows you to evaluate how much to correct the burst x with respect to a reference value
chosen by the operator:
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The  program  automatically  calculates  the  geometric  correction  for  each  single  burst  by
applying the law:

Tcorr= z
r
×T dover=√z2+ x2
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 5.1  Intercept

The  graphical  method
consists  in  selecting  the
segment that includes the
points  that  line  up
indicating  a  constant
speed of propagation.  By
analyzing  the  inverse  of
the angular coefficient of
this segment, it is possible
to evaluate  the speeds of
the layer.
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 5.2  Pseudo-interval

The interval technique is based on the
fact  that  the  acquisition  is  performed
with the use of two sensors, placed at a
constant distance in the hole.  the two
sensors  move  along  the  hole  with  a
constant displacement distance.

The  pseudo-interval  technique  allows
to  analyze  the  data  acquired  with  a
single  sensor,  as  if  they  had  been
acquired as described above.

Obviously this leads to an error which
is  mitigated  by  the  use  of  the  spy
geophone.

The  software  calculates  the  interval
speed following this law:

V=
Zn−Zn−1

Tcorrn−Tcorrn−1
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 5.3  Equivalent velocity

This  processing  method  uses
the same assumptions described
in  the  previous  technique,
keeping the surface sensor at a
fixed  height,  in  this  case  the
most superficial depth.

The  software  calculates  the
equivalent speed following this
law:
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 5.4  Formulas

The formulas used in the software are as follows:

Calculation of correct times:

• Correct Times

Tcorr= z
r
×T dover=√z2+ x2

• Poisson

((VP /VS)2−2)
2((VP /VS)2−1)

Valid if: | |VP /VS|≠1  and Poisson > 0.16 and Poisson < 0.5

• Density (T/m^3)

0.51(VP0.19)

• Bulk (MPa)

(Density(VP2−( 4
3
)VS2))

1000

• Young (MPa)

((VS
2)∗Density∗(3VP2−4VS2)

(VP2−VS2)
)/1000

• Shear (MPa)

(Density(VS2))
1000
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